Technical Notes on FLEXx Text Interlinear
November 13, 2025

Ken Zook

Contents

Technical Notes on FLEX Text INterliNEAr ..........ooeivcviiii it

R 1911 (0 o 0T £ o) o

N o 1) () A {1 LT 1 (0o (0 =S
0 R 1= (=) A 1 (=
A | 41 (=] [ 1CT: T () SR
2.3 PaAragraph.....c e ns 4
R o 1 - 1) TSR 4
228 T AV Lo o [
2.6 MOTPN .. e

3 Mapping FLEX interlinear to flextext fields ...........ccocviveiieiiicse e

4 FLEX TEXEEXPOIT ...ttt

5 FLEX TEXEIMPOIT ...oeiivieiieie ittt ettt et st be e sne e e sneenraeee s
5.1 Merge flextext into eXiStiNg tEXL ........ccueiriiiiieierere e 10
5.2  Create a new text from fIEXIEXt.....ccooiviiiiiii e 11

B SAMPIE AL ... 13
TR R T 1 (0] Tt I GO 13
(T T [0 1 (0] T = N RO 15
6.3 File from SAYMOIE .....cveiieieeee e 16

T FLEX TeXt XML SCNBMA.......uviiiiiitiiie ettt et e s 17

1 Introduction

FLEx Text is an XML interchange format for importing and exporting Interlinear text in
FieldWorks Language Explorer (FLEX) (https://software.sil.org/fieldworks) and other
programs, such as ELAN (https://archive.mpi.nl/tla/elan) and SayMore
(https://software.sil.org/saymore/). The file extension is flextext. A flextext file may hold
multiple interlinear texts.

For information on how interlinear texts are stored in FLEX, see
https://downloads.languagetechnology.org/fieldworks/Documentation/FLEx%209.1%20
Conceptual%20Model.pdf.

When exporting from FLEX to flextext, the program is not directly accessing the FLEx
data, but is exporting the data from the configured interlinear text view (Tools >
Configure > Interlinear). By altering the options in Interlinear Configuration, it will alter
the data and order that is included in the flextext file. Before exporting, make sure you
have your interlinear text displaying the fields and writing systems you want to include in
the flextext file. When importing flextext data to FLEX, it will import the data in the
flextext file, but will only display data that is currently set in Interlinear Configuration.
When importing a flextext file, make sure your project has the writing systems used in
the flextext file.



https://software.sil.org/fieldworks
https://archive.mpi.nl/tla/elan
https://software.sil.org/saymore/
https://downloads.languagetechnology.org/fieldworks/Documentation/FLEx%209.1%20Conceptual%20Model.pdf
https://downloads.languagetechnology.org/fieldworks/Documentation/FLEx%209.1%20Conceptual%20Model.pdf
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2 Flextext file structure

This section does not describe every possibility in a flextext file, but covers the common
elements. For a full description, see the XML Schema in section 77.

2.1 Flextext file
The flextext file is an XML file with this basic structure.

<?xml version="1.0" encoding="utf-8"?>

<document version="3">
<interlinear-text guid="db49c7a0-63fc-4a0a-bb9f-d3defOfeb543">
</interlinear-text>

</document>

The file may have an optional U+FEFF BY TE ORDER MARK character at the
beginning. There is one document element with an optional version attribute which is
currently 2 in FLEx 9.2.11. A flextext file may contain multiple interlinear-text elements.
Each of these elements represents one interlinear Text object in FLEX.

In FLEX9.3.5 the document version changed to 3. This change maintains writing system
and style embeddings in text baselines, translations, and notes during flextext export and
import. It also maintains multiple writing systems in multiple notes. This means that a
flextext export in version 9.3.5 or later will work better. However, if you try to read a
version 3 flextext file in an older version of FLEX, it will leave empty paragraphs if the
text has these embeddings since the older version cannot handle the new structure. There
may also be issues with ELAN until ELAN adjusts to the new version. The potential
problems will not occur if you are not adding embeddings to interlinear strings.

In version 2, embedded writing system and style information was lost during an export.
The text was exported as a single string without embeddings. With Notes, each writing
system was treated as a separate note. If you start out with 2 notes, each with en and es
strings, when it is imported, you would get 4 notes, 2 with en strings and 2 with es
strings.

2.2 Interlinear-text

An interlinear-text element has this basic structure.

<interlinear-text guid="db49c7a0-63fc-4a0a-bb9f-d3defOfeb543">
<item type="title" lang="en">The boy story</item>
<paragraphs>
<paragraph guid="904ea0c5-975f-400c-94be-0bb30f356b05">
</paragraph>
</paragraphs>
<languages>
<language lang="en" font="Times New Roman" />
<language lang="fr" font="Times New Roman" vernacular="true" />
</languages>
<media-files offset-type="">
<media guid="df7d67a9-00a6-4ed8-9241-c6177850686f"
location="file:///C:/Users/pa/Desktop/Collections/story.wav"/>
</media-files>
</interlinear-text>
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An interlinear-text has

o An optional guid attribute that holds the guid of the FLEX Text object when a text is
exported from FLEX to flextext. This is used during importing a flextext file to
determine whether FLEX already has the text being imported, and if so it offers to
merge the flextext data into the current Text, or create a new Text object with a new
guid during the import.

e There can be any number of item elements with type “title”; one for each language
(writing system). This is the title for the text.

o There is a single required paragraphs element containing zero or more paragraphs.

e There is also an optional languages element containing language elements. There
should be one language element for each language (writing system) used in the
interlinear-text. Each one has a “lang” attribute defining the writing system, an
optional “font” attribute giving the default font for the writing system, and an optional
“vernacular” attribute set to “true” for the primary vernacular writing system for the
text baseline.

e There is an optional media-files element with an “offset-type” attribute (normally null
string: "), and zero or more media elements with a “guid” attribute, and a “location”
attribute giving the full path to the media file.

While FLEX does not provide Ul for media files, it does store the data in the fwdata file
so that it can roundtrip the information via flextext to ELAN, etc. Note that the
interlinear-text guid and the media guid are maintained when importing from flextext, but
the paragraph guids are not maintained.

This is the relevant data in fwdata for saving this information

<rt class="Text" guid="db49c7a0-63fc-4a0a-bb9f-d3defOfeb543">
<MediaFiles>

<objsur guid="308cb504-a117-4441-a2ch-0d35ad7¢c5923" t="0" />
</MediaFiles>

</rt>

The interlinear text is in a Text object. The Text owns a single CmMediaContainer in the
MediaFiles property.

<rt class="CmMediaContainer" guid="308cb504-a117-4441-a2cbh-0d35ad7c5923"
ownerguid="db49c7a0-63fc-4a0a-bb9f-d3defOfeb543">

<MediaURIs>

<objsur guid="df7d67a9-00a6-4ed8-9241-c6177850686f" t="0" />

</MediaURIs>

</rt>

The CmMediaContainer owns zero or more CmMediaURI objects.

<rt class="CmMediaURI" guid="df7d67a9-00a6-4ed8-9241-c6177850686f"
ownerguid="308cb504-a117-4441-a2ch-0d35ad7¢c5923">

<MediaURI>

<Uni>file:///C:/Users/pa/Desktop/Collections/story.wav</Uni>

</MediaURI>

</rt>

The CmMediaURI has a Unicode string in the MediaURI property for the path to the
media file.
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2.3 Paragraph

A paragraph element has this structure.

<paragraph guid="e3a65332-afe5-49f0-afc4-334871e0a663">
<phrases>
<phrase guid="e637f22c-9020-4hd7-8292-48b3dd6823fa">
</phrase>
</phrases>
</paragraph>

The paragraph element has an optional guid attribute which corresponds to the StTxtPara
object that was exported from FLEX to flextext.

A paragraph element has a single phrases element that holds any number of phrase
elements.

2.4 Phrase

A simple phrase element from FLEX has this structure.
<phrase guid="e637f22c-9020-4bd7-8292-48b3dd6823fa">

<item type="segnum" lang="en">1</item>
<words>
<word guid="e9a04fd4-6f47-48ae-97b5-9344c6f78049">
</word>
</words>
<item type="gls" lang="en">The boy.</item>
</phrase>

In flextext version 3 (FW9.3.5 and later), the above format still works. However, if you
have embedded writing systems and styles, a new structure is provided to maintain the
embeddings. Instead of a simple string in one writing system as shown above, the string
is broken into run elements with writing system and optional style included in each run.
This option for embedding is available in the baseline “txt” field, the free translation
“gls” field, the literal translation “lit” field, and the notes “note” field. Here is an example
of an English free translation with two French words with the first set to bold.

Free Free English translation with embedded gras francais.

<item type="gls" lang="en">
<run lang="en">Free English translation with embedded </run>

<run lang="fr">francais</run>
<run lang="en">.</run>
</item>

The phrase element has

« An optional guid attribute which corresponds to the Segment in FLEX.
e Since a FLEXx baseline is a String instead of MultiString, there will only be one item
element with type “txt” with the vernacular writing system coming from the Word
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interlinear line, and this is optional as long as there are word elements specifying the
text. Flextext version 3 supports embedded writing systems and styles.

e There is an optional item with type “segnum”. This is the segment number which in
FLEX is calculated automatically based on paragraph and segment numbers, and
appears at the beginning of the Paragraph in the Word interlinear line.

e There can be any number of item elements with type “gls”; one for each analysis
writing system. This is the free translation from the Free interlinear line (FLEX
Segment FreeTranslation). Flextext version 3 supports embedded writing systems and
styles.

e There can be any number of item elements with type “lit”; one for each analysis
writing system. This is the literal translation from the Lit. interlinear line (FLEx
Segment LiteralTranslation). Flextext version 3 supports embedded writing systems
and styles.

e There can be any number of item elements with type “note”; one for each analysis
writing system. This is the Note from the Note interlinear line (FLEx Segment Notes
Note Content). Flextext version 3 supports embedded writing systems and styles.

e There is an optional single words element that holds any number of word elements.

Translation and Note fields in FLEx are MultiStrings, meaning a user can have
translations in multiple writing systems and can embed writing systems and styles in
these strings. In flextext version 2, any embedded writing system and style information
will be removed, leaving the text in one writing system with no embedded styles.

In flextext version 2, there was also an issue with notes when you use multiple writing
systems. A separate “note” item was included for each translation. If you start out with
two notes, each with two writing systems, the export had four note items:

<item type="note" lang="en">This is a note about this Bold sentence.</item>

<item type="note" lang="es">This is the Spanish note with English embedded.</item>
<item type="note" lang="en">This is a second English note.</item>

<item type="note" lang="es">The second Spanish</item>

Since flextext did not have a way to indicate that these are really two notes, when it gets
imported into FLEX, the result was four notes, each with one writing system, instead of
two notes.

In flextext version 3 a new groupid attribute is added to the “note” field. This allows
FLEX to maintain the original note structure with multiple writing systems, which can
also have embedded writing systems and styles.

<item type="note" groupid="1" lang="en">The first English note.</item>
<item type="note" groupid="1" lang="fr">La premiére note francaise.</item>
<item type="note" groupid="2" lang="en">A second English note.</item>

<item type="note" groupid="2" lang="fr">Une deuxiéme note francaise.</item>

In ELAN and SayMore files, additional phrase attributes are used to display information
about the location in a media file.

<phrase begin-time-offset="316926"
end-time-offset="317266"
guid="76713b5a-2ee6-4b6e-938a-e6f5af498ch3"
media-file="df7d67a9-00a6-4ed8-9241-c6177850686f" speaker="John Doe">
<item lang="ew-fonipa" type="txt">dona</item>
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<item lang="en" type="gls">lt is finished.</item>
</phrase>

Attributes “begin-time-offset” and “end-time-offset” specifies an index into a media file
for this phrase. A “media-file” attribute holds the guid for the media for this segment.
The media file information should match one of the media elements in the media-files
element of the interlinear-text.

While FLEXx does not provide Ul for media file information, it does store the data in the
fwdata file so that it can roundtrip the information via flextext. The phrase guid is
maintained in the Segment guid during import. These are the relevant fields in the
Segment.

<rt class="Segment" guid="76713b5a-2ee6-4b6e-938a-e6f5af498cb3" ownerguid="451dcf94-

d3cc-4blc-b919-4d487a25ad06">

<BeginTimeOffset>

<Uni>316926</Uni>

</BeginTimeOffset>

<EndTimeOffset>

<Uni>317266</Uni>

</EndTimeOffset>

<MediaURI>

<objsur guid="df7d67a9-00a6-4 ed8-9241-c6177850686f" t="r" />

</MediaURI>

<Speaker>

<objsur guid="d0d0dda8-7354-431d-bba0-739bed01a2¢c3" t="r" />

</Speaker>

</rt>

The time offsets are millisecond values stored as Unicode strings in BeginTimeOffset and
EndTimeOffset. The MediaURI property references a single CmMediaURI object in the
Text. The Speaker property references a single CmPerson object in the People list. On
import, CmPerson objects will be added to the People list if they are not already present.

2.5 Word

When exporting FLEX data to flextext, it will only export data that you have enabled in
Interlinear Configuration.

Word elements are not required. If there are multiple words in the phrase “txt” item, and
there are no Word elements in flextext, FLEx will parse the txt item into unanalyzed
wordforms during import. FLEX allows multiple words in a wordform (e.g., “kick the
bucket”). This will be exported correctly as long as there are word elements with the
multiple words. However, if you are importing a baseline without word elements, each
word will be a separate wordform.

An unanalyzed word element has this structure.

<word guid="e124f206-d156-4c2c-b046-457ee720b143">
<item type="txt" lang="fr">Le</item>
</word>

The FLEx Analyses link is to the WfiWordform containing the form of the word. In
flextext, the word has one or more item elements with type “txt” and “lang” attribute for
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the writing system; one for each vernacular writing system. The body of the item is the
Word interlinear line (FLEx WfiWordform Form).

The FLEX Analyses link is to the WfiGloss for a fully analyzed word. In flextext, the
word element has this structure.

<word guid="e9a04fd4-6f47-48ae-97b5-9344c6f78049">
<item type="txt" lang="fr">gargon</item>
<morphemes>
<morph type="stem" guid="d7f713e8-e8cf-11d3-9764-00c04f186933">
</morph>
</morphemes>
<item type="gIs" lang="en">boy</item>
<item type="pos" lang="en">n</item>
</word>

The word element has an optional guid attribute which corresponds to the WfiGloss
object in FLEX. The word element has the following content

e 0One or more “txt” items; one for each vernacular writing system coming from the
Word interlinear line (FLEx WfiWordform Form).

o amorphemes element that holds zero or more morpheme elements within the FLEX
WfiWordform Analyses.

e zero or more “gls” items for the word gloss; one for each analysis writing system
from the Word Gloss interlinear line (FLEx WfiGloss Form).

e zero or more “pos” items for the word category; one for each analysis writing system
that comes from the Word Cat. interlinear line (FLEx PartOfSpeech referenced from
WfiAnalysis Category).

The FLEX Analyses link is to the WfiAnalysis for a partially analyzed word. The export
to flextext is similar to a fully analyzed word except the “gls” element will usually be
missing.

A punctuation (or text in a writing system other than the top vernacular writing system)
has this structure

<word>

<item type="punct" lang="fr">.</item>
</word>

The guid is not shown here, but the FLEX object being exported is a PunctuationForm
object that stores the punctuation text and writing system. The punctuation in flextext is
exported as an item with type “punct” and “lang” giving the writing system code. The
content of the item is the punctuation or text that is in a writing system other than the top
vernacular writing system (FLEx PunctuationForm Form).

2.6 Morph

A morph element represents a morpheme within a word and has this structure.

<morph type="stem" guid="d7f713e8-e8cf-11d3-9764-00c04f186933">
<item type="txt" lang="fr">gargcon</item>
<item type="cf" lang="fr">garcon</item>

<item type="gls" lang="en">boy</item>
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<item type="msa" lang="en">n</item>
</morph>

The morph element has an optional “type” attribute listing the FLEx MoMorphType
Name, and optional “guid” attribute listing the FLEx MoMorphType guid. The morph
element has the following content

e one or more “txt” items for the word; one for each vernacular writing system from the
Morphemes interlinear line (FLEx LexEntry LexemeForm MoForm Form).

e zero or more “cf” items for the Lex. Entries interlinear line (FLEx LexEntry
LexemeForm MoForm Form). (The abbreviation was probably for citation form at
some point, but it is really the lexeme form, so should probably be “1f”. However it’s
too hard to change at this point.)

e an optional “hm” item for a homograph number from LexEntry HomographNumber
property. In the display this is appended to the lexeme form.

e zero or more “gls” items for the sense gloss; one for each analysis writing system
from the Lex. Gloss interlinear line (FLEXx LexSense Gloss).

e zero or more “msa” items for the grammatical category; one for each analysis writing
system from the Lex. Gram. Info. interlinear line (FLEx LexSense
MorphoSyntaxAnalsis PartOfSpeech Abbreviation property.

3 Mapping FLEX interlinear to flextext fields

The various fields that get exported from configured data are exported into item elements
with a “type” attribute specifying the type of data, and a “lang” attribute specifying the
writing system. This table shows the correspondence between the configuration labels

and the type used in flextext.

Interlinear Label Element Item Type
Word word txt
Morphemes morph txt
Lex. Entries morph cf/hn
Lex. Gloss morph gls
Lex. Gram. Info. morph msa
Word Gloss word gls
Word Cat. word pos
Free Translation phrase gls
Literal Translation phrase lit
Note phrase note

FLEXx exports guids from the fwdata file to a flextext file. The following chart maps

between flextext and FLEX guids:

Flextext Element guid FLEXx Class guid

interlinear-text Text

paragraph StTxtPara

phrase Segment

media CmMediaURI

word WifiWordform/WfiAnalysis/WfiGloss
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| morph-type | MoMorphType \

The word guid corresponds to the Segment Analyses reference links. When unanalyzed,
this will be a Wfiwordform. When partially analyzed, it will be a WfiAnalysis. When
fully analyzed, it will be a WfiGloss. Punctuation (or text in a writing system other than
the writing system for the text) will be a “punct” word element without a guid even
though the underlying PunctuationForm object does have a guid.

When importing and merging, FLEX attempts to update the existing data with the existing
guids. When importing as a new text, these guids are ignored and new owning objects
with guids will be created.

4 FLEXx Text export

When exporting to flextext from FLEX, the program is not directly accessing the FLEx
data, but is exporting the data from the Interlinear Text configured view. By altering the
options in Interlinear Configuration, it will alter the data that is included in the flextext
file.

To export a flextext file from FLEX:

1. Inthe Texts & Words area, use the Interlinear Texts tool to open an interlinear text.

2. Go to the Gloss, Analyze, Tagging, or Print View tab on the text.

3. Choose File > Export Interlinear from the main menu to open the Export Interlinear

dialog.

Click the “ELAN, SayMore, FLEx FLEXTEXT” option, then click Export.

A Choose Texts dialog will open where you can choose the text(s) to export. (Note in

FW09.2.10 this takes about 25 seconds the first time LT- 22247.) The current text is

preselected. Click OK to start the export.

6. Inthe “Export to FLEXTEXText” dialog that opens, specify the directory and file
name, then click Save to export the file.

o~

When FLEX exports a text, it always writes out the current guids for text objects
including classes for Text, StTxtPara, Segment, and WfiWwordform, WfiAnalysis, or
WfiGloss, depending on the state of analysis.

5 FLEXx Text import

Before importing a flextext file, you should verify that FLEX has the correct vernacular
and analysis writing systems used in the file. A flextext import will not create missing
writing systems, and will only display the imported data if the desired writing systems are
enabled in configuration.

To import a flextext file into FLEX:

1. From the main menu in the Texts & Words area, choose File > Import > FLEx Text
Interlinear

2. Select the flextext file to import in the FieldWorks interlinear (FLEx Text) file dialog
and click OK to start the import.

3. If the flextext came from a previous FLEX export, a “Duplicate text found” dialog
will ask if you want to merge the flextext text with the existing text.
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Click “Yes” if you want to merge the flextext file with the existing text. This
essentially makes the FLEX copy identical to the flextext copy.

Click No if you want to create a new text.

If you are importing multiple texts, this dialog will repeat for each duplicate text
found. Unfortunately, it doesn’t tell which text is being overwritten, so this could be
confusing (LT-22167).

Note: FW9.2.2 through FW9.2.10 had a serious bug that damaged existing data during
either choice (LT-22249). This has been corrected in FW9.2.11 as described below.

Note: When importing a version 3 flextext into FLEX versions prior to FW9.3.5, if the
paragraph contains embedded writing systems or styles, the paragraph data will not be
imported into the text, leaving a blank paragraph.

When importing wordforms, if the flextext file has multiple writing systems for words, it
will use the primary writing system to find an existing wordform. If the existing
wordform does not have writing systems included in the flextext file, the import will add
the additional writing systems to the existing wordform. However, if any of the additional
writing systems are already in the existing wordform, the writing system from flextext
will be ignored rather than overwriting the FLEx WfiWordform writing system.

When importing morphs, if the fields in the flextext morph match corresponding fields in
a FLEx analysis (WfiMorphBundle), it will use that analysis in FLEX. If the flextext
morph has additional fields that are not in the analysis in FLEXx, then a new analysis will
be created in FLEX rather than adding to an existing analysis.

5.1 Merge flextext into existing text

When you choose “Yes” to the “Duplicate Text Found” dialog, FLEX will use the guids
in the flextext file to attempt to modify any text elements based on the flextext file. This
process should not change any existing analyses that could be used by other texts, but it
will attempt to make the existing text a copy of the flextext data. Existing analyses should
not be changed in this operation. If there are new morphs, it works similar to making a
copy of the text. If existing analyses are found that match the flextext morph, the import
will link to those analyses during the import. Otherwise, as of FW9.2.11, the wordform
will remain unanalyzed. In some later version of FLEX, we hope to create entries and
analyses that are new to this text, as long as morph properties are included.

Here is an example of changes in flextext being merged into the existing text. This is the
original text.

Info Baseline Gloss Analyze Tagging Print View Text Chart

1 Word Le B8 gargon
Morphemes [*] 1e gargon
Lex. Entries [v] **+* gargon
Lex Gloss B baoy
Lex. Gram. Info. e n
Word Gloss boy
Word Cat i n

= &
Free The boy.

| exported the above text to flextext, then in flextext:
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e Changed the baseline to “Le jeune garcon.”

o Changed the free translation to “The young boy.”

e Added a second paragraph with this baseline “Le garcon le plus &gé.” with no word
elements.

e And this free translation “The older boy”

| then imported the modified flextext file, merging into the existing text giving this result.

Info Baseline Gloss Analyze Tagging  Print View Text Chart

1 Word Le @ jeune  gargon
Morphemes [*] 1e ok Zargon
Lex Entries [¥] *** ek gargon
Lex. Gloss o *¥EE poy
Lex. Gram. Info. e wE g
Word Gloss whk boy
Word Cat [x] *** ¥EE o

= G

Free The young boy.

2 Word Le gargon le plus Agé
Morphemes Fkk ga.f;oﬂ * ke * ke *kk
Lex_ Entries Fkk ga.t’gﬂﬂ &k &k dkk
Lex_ Gloss Fkk bn}- &k &k dkk
Lex_ Gr\am_ Info_ Fkk a1 &k &k dkk
word GIOSS Fdk bny F Ak F Ak F A
word Cat Fdk 11 F Ak F Ak F A

Free The older boy.

The second paragraph did not display the interlinear bundles until I went to another text
and then back again, so there is a refresh issue, but otherwise it worked as expected.

e The original “garcon” wordform remained approved, and an unanalyzed “jeune” was
inserted. The original translation was changed to what was in the flextext file.

« The second paragraph was added with the translation. The analysis for “garcon” was
not approved, but the guesser had the correct analysis ready to approve.

5.2 Create a new text from flextext

When you choose “No” to the “Duplicate Text Found” dialog, the guids in the flextext
file will be ignored and new objects will be created in FLEX for all objects owned by the
new text. If existing analyses are found that match the flextext morph, the import will
link to those analyses during the import. Otherwise, new analyses will be added to the
wordform. In some later version of FLEX, we hope to create entries and analyses that are
new to this text, as long as morph elements are included. Nothing in existing texts with
approved analyses should change when creating a new text. For user unapproved
analyses, an analysis guesser tries to find an appropriate analysis and display it with a
blue background. When importing a new text, even though the actual data for the existing
text 1s not changed, it’s possible that the guesser may come up with a different guess. In
this case, the original analysis is still intact, and can be selected and approved via the
normal manual interlinearization options.

In the above example, when choosing not to merge, the original text was unchanged, and
this was the new text.
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Info Baseline Gloss Analyze Tagging Print View Text Chart

1 Word Le @D jeune  gargon
Morphemes =] fe ik gargon
Lex. Eniries [v] ¥** ek gargon
Lex. Gloss B *£* oy
Lex. Gram. Info. . #rE g
Word Gloss HkE boy

E EE £ -
Word Cat. Hww n
= G

Free The voung boy.

2 Word Le gargon e plus  Agé
Morphemes F ok gﬂ.ﬂ;ﬂﬂ dak ok Fakk Fakk
Lex- Enmes F ok g,a.ﬂ;on dak ok Fakk Fakk
Lex_ Gloss EL 21 bo}- Hokk *okk Hokk
Lex_ Gr\am_ Info_ EL 21 1 Hokk *okk *okk
wOrd Gloss EE 3 boy B B B
wOrd Ca‘_ EE 3 1 B B B

Free The older boy.

Note, when importing a text, if you have a baseline txt element on the phrase, this will be
the baseline even if you have other words in the words element. When you are importing
word elements, if there is no morphemes element, the import will still add an analysis
with the word gloss (gls) from the flextext file when adding new wordforms. So this
provides one way to import wordforms with word glosses.
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6 Sample data

6.1 File from FLEX:
This is a simple text in FLEX.

1 Word base Le gargon
Word Frelpa la gagsd
Morphemes base = **% gargon
Morphemes Frelpa *** gagsd

Lex. Entnes bk gargon
Lex. Gloss bst. an  *#*% boy
Lex. Gloss Spa Ekk nifio
Lex. Gram. Info. ok n

Word Gloss Eng *E% boy
Word Gloss Spa *E% nifio
Word Cat. Hkk n

Free Eng The boy.
Spaz El nifio.

Mote Eng This is a note about this sentence.
Spz Esta es una nota sobre esta oracion.

This is the exported flextext file for this simple text.

<document version="2">
<interlinear-text guid="23dab191-81f0-4588-a15b-2246432c993f">
<item type="title" lang="en">The boy story</item>
<paragraphs>
<paragraph guid="e3a65332-afe5-49f0-afc4-334871e0a663">
<phrases>
<phrase guid="e637f22c-9020-4bd7-8292-48b3dd6823fa">
<item type="txt" lang="fr">Le garcon.</item>
<item type="segnum" lang="en">1</item>
<words>
<word guid="e124f206-d156-4c2c-b046-457ee720b143">
<item type="txt" lang="fr">Le</item>
<item type="txt" lang="fr-fonipa">la</item>
</word>
<word guid="e9a04fd4-6f47-48ae-97b5-9344c6f78049">
<item type="txt" lang="fr">gargon</item>
<item type="txt" lang="fr-fonipa">gasi</item>
<morphemes>
<morph type="stem" guid="d7{713e8-e8cf-11d3-9764-00c04f186933">
<item type="txt" lang="fr">gargon</item>
<item type="txt" lang="fr-fonipa">gassd</item>
<item type="cf" lang="fr">garcon</item>
<item type="glIs" lang="en">boy</item>
<item type="gls" lang="es">nifio</item>
<item type="msa" lang="en">n</item>
</morph>
</morphemes>
<item type="gIs" lang="en">boy</item>
<item type="gls" lang="es">nifio</item>
<item type="pos" lang="en">n</item>
</word>
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<word>
<item type="punct" lang="fr">.</item>
</word>
</words>
<item type="gIs" lang="en">The boy.</item>
<item type="gIs" lang="es">El nifio.</item>
<item type="note" lang="en">This is a note about this sentence.</item>
<item type="note" lang="es">Esta es una nota sobre esta oracién.</item>
</phrase>
</phrases>
</paragraph>
</paragraphs>
<languages>
<language lang="en" font="Times New Roman" />
<language lang="fr" font="Times New Roman" vernacular="true" />
<language lang="fr-fonipa" font="" vernacular="true" />
<language lang="es" font="Times New Roman" />
</languages>
</interlinear-text>
</document>
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6.2 File from ELAN

This is a sample flextext file generated in ELAN. Note it includes media file and offset
information that is stored in FLEX so that it can be exported from FLEX, but it is not
supported in the FLEx UI. Files from ELAN normally do not have morpheme
information, unless it was supplied at some point from FLEX.

<?xml version="1.0" encoding="UTF-8"?>
<document version="2">

<interlinear-text guid="db49c7a0-63fc-4a0a-bb9f-d3defOfeb543">
<paragraphs>

<paragraph guid="904ea0c5-975f-400c-94be-0bb30f356b05">
<phrases>

<phrase begin-time-offset="316926"
end-time-offset="317266"
guid="76713b5a-2ee6-4b6e-938a-e6f5af498ch3"
media-file="df7d67a9-00a6-4ed8-9241-c6177850686f" speaker="John Doe">
<item lang="ew-fonipa" type="txt">dona</item>

<item lang="ne" type="gls">TT THTCT AT |</item>

<item lang="en" type="gls">It is finished.</item>

</phrase>
</phrases>

</paragraph>
</paragraphs>

<media guid="df7d67a9-00a6-4ed8-9241-c6177850686f"
location="file:///C:/Users/pa/Desktop/Collections/story.wav"/>
</media-files>

</interlinear-text>
</document>
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6.3 File from SayMore

This is a sample flextext file generated in SayMore. Note it includes media file and offset
information that is stored in FLEX so that it can be exported from FLEX, but it is not
supported in the FLEx Ul. Also note that these files do not include morpheme
information.

<?xml version="1.0" encoding="utf-8"?>
<document>
<interlinear-text>
<item type="title" lang="fr">Feuille de baobab.wav</item>
<paragraphs>
<paragraph>
<phrases>
<phrase begin-time-offset="68902" end-time-offset="70502" media-file="a0d6501b-15de-
469f-b3e3-e5d585bb5b7c¢">
<item type="segnum" lang="fr">19</item>
<item type="txt" lang="mxI">mo & no dagbe o ne</item>
<item type="gIs" lang="fr">c'est comme ¢a on prepare</item>
<words />
</phrase>
</phrases>
</paragraph>
</paragraphs>
<languages>
<language lang="mxI" />
<language lang="fr" />
</languages>
<media-files offset-type="">
<media guid="a0d6501b-15de-469f-b3e3-e5d585bb5b7c"
location="C:\Users\Joe\Documents\SayMore\Maxi recipes\Sessions\Feuille de baobab\Feuille
de baobab.wav" />
</media-files>
</interlinear-text>
</document>
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7 FLEx Text XML Schema

The flextext technical file structure is defined in FlexInterlinear.xsd located in
C:\Program Files\SIL\FieldWorks 9\Language Explorer\Export Templates\Interlinear.
The content of the xsd is included below. This can be used to validate a flextext file to
make sure it has the correct structure.

Unfortunately, FLEx does not give helpful information when a flextext file is not
structured properly or has invalid data. A start would be to validate the flextext file to
make sure it has valid structure. There are various online and offline tools you can use to
validate a file with this XSD schema. One online option is
https://www.freeformatter.com/xml-validator-xsd.html

If this does not solve the problem, you’ll need to get technical help from flex-
errors@sil.org to import the data in a debugger to determine where it is failing, or you
could attempt to use the dnSpy debugger without having a FLEx development system.
See section 3.5 of
https://downloads.languagetechnology.org/fieldworks/Documentation/FLEx%209.1%20
Conceptual%20Model.pdf for more information on this.

This is the XSD schema for flextext version 3 introduced in FW?9.3.5.

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns="" xmlns:xs="http://www.w3.0rg/2001/XMLSchema" id="document">
<xs:element name="document">
<xs:complexType>
<xs:sequence>
<xs:element name="interlinear-text" minOccurs="1" maxOccurs="unbounded">
<xs:complexType>
<xs:sequence minOccurs="0" maxOccurs="unbounded">
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>

<xs:complexType>
<xs:.sequence>
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<xs:attribute name="guid" type="xs:string" use="required"/>
<xs:attribute name="type" type="objectTypes" use="required"/>
</xs:complexType>
</xs:element>
</xs.sequence>
</xs:complexType>
</xs:element>
<xs:element name="paragraphs" minOccurs="1" maxOccurs="1">
<xs:complexType>
<xs:sequence minOccurs="1" maxOccurs="1">
<xs:element name="paragraph" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:all>
<xs:element name="phrases" minOccurs="1" maxOccurs="1">
<xs:complexType>
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<xs:.sequence>
<xs:element name="phrase" minOccurs="0" maxOccurs="unbounded">
<xs:.complexType>
<xs:.sequence>
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>
<xs:element name="words" minOccurs="1" maxOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element name="scrMilestone" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:attribute name="chapter" type="xs:integer" use="required" />
<xs:attribute name="verse" type="xs:integer" use="required" />
</xs:complexType>
</xs:element>
<xs:element name="word" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>
<xs:element name="morphemes" minOccurs="0" maxOccurs="1">
<xs:.complexType>
<xs:sequence>
<xs:element name="morph" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:sequence>
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>
</xs.sequence>
<xs:attribute name="type" type="morphTypes"/>
<xs:attribute name="guid" type="xs:string"/>
</xs:complexType>
</xs:element>
</xs.sequence>
<xs:attribute name="analysisStatus" type="analysisStatusTypes"
use="optional"/>
</xs:complexType>
</xs:element>
</xs:choice>
<xs:attribute name="guid" type="xs:string"/>
<xs:attribute name="type" type="xs:string" fixed="phrase" use="optional" />
</xs:complexType>
</xs:element> <!-- word -->
</xs:sequence>
</xs:complexType>
</xs:element> <!-- words -->
<xs:element ref="item" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
<!-- media-file should match a guid of one of the media elements for the enclosing
text -->
<xs:attribute name="media-file" type="xs:string" use="optional"/>
<xs:attribute name="begin-time-offset" type="xs:string" use="optional"/>
<xs:attribute name="end-time-offset" type="xs:string" use="optional"/>
<xs:attribute name="guid" type="xs:string"/>
<xs:attribute name="speaker" type="xs:string" use="optional"/>
</xs:complexType>
</xs:element> <!-- phrase -->
</xs:sequence>
</xs:complexType>
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</xs:element> <!-- phrases -->
</xs:all>
<xs:attribute name="guid" type="xs:string"/>
</xs:complexType>
</xs:element> <!-- paragraph -->
</xs:sequence>
</xs:complexType>
</xs:element> <!-- paragraphs -->
<xs:element name="languages" minOccurs="0" maxOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element name="language" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:attribute name="lang" type="xs:string" use="required"/>
<xs:attribute name="encoding" type="xs:string" use="optional"/>
<xs:attribute name="font" type="xs:string"/>
<xs:attribute name="vernacular" type="xs:boolean"/>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
<xs:key name="langld">
<xs:selector xpath="language"/>
<xs:field xpath="@lang"/>
</xs:key>
</xs:element>
<xs:element name="media-files" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:sequence>
<xs:element name="media" minOccurs="0" maxOccurs="unbounded">
<xs:.complexType>
<xs:attribute name="guid" type="xs:string" use="required"/>
<!-- location should follow the media fragment specification -->
<xs:attribute name="location" type="xs:anyURI" use="required"/>
</xs:complexType>
</xs:element>
</xs:sequence>
<xs:attribute name="offset-type" type="xs:string"/>
</xs:complexType>
</xs:element>
</xs:sequence>
<xs:attribute name="guid" type="xs:string" use="optional"/>
<xs:attribute name="scrSectionType" type="scrSectionTypes" use="optional"/>
<xs:attribute name="scrBook" type="xs:string" use="optional"/>
</xs:complexType>
</xs:element> <!-- interlinear-text -->
</xs:sequence>
<xs:attribute name="exportSource" type="xs:string" use="optional"/>
<xs:attribute name="exportTarget" type="xs:string" use="optional"/>
<xs:attribute name="version" type="xs:string"/>
</xs:complexType>
</xs:element> <!-- document -->
<xs:element name="item" nillable="true">
<!-- item can either be a sequence of runs or a string.
It can't have runs embedded in a string even though mixed="true" allows it. -->
<xs:complexType mixed="true">
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<xs:.sequence>
<xs:element name="run" minOccurs="0" maxOccurs="unbounded">
<xs:complexType>
<xs:simpleContent>
<xs:extension base="xs:string">
<xs:attribute name="lang" type="xs:string" use="required"/>
<xs:attribute name="style" type="xs:string" use="optional"/>
</xs:extension>
</xs:simpleContent>
</xs:complexType>
</xs:element>
</xs:sequence>
<xs:attribute name="type" type="itemTypes" use="required"/>
<xs:attribute name="guid" type="xs:string" use="optional"/>
<xs:attribute name="groupid" type="xs:string" use="optional"/>
<xs:attribute name="lang" type="xs:string" use="required"/>
<xs:attribute name="analysisStatus" type="analysisStatusTypes" use="optional"/>
</xs:complexType>
</xs:element>
<xs:simpleType name="knownltemTypes">
<xs:restriction base="xs:string">
<xs:enumeration value="txt"/>
<xs:enumeration value="cf"/>
<xs:enumeration value="hn"/>
<xs:enumeration value="variantTypes"/>
<xs:enumeration value="glIs"/>
<xs:enumeration value="msa"/>
<xs:enumeration value="pos"/>
<xs:enumeration value="title"/>
<xs:enumeration value="title-abbreviation"/>
<xs:enumeration value="source"/>
<xs:enumeration value="comment"/>
<xs:enumeration value="text-is-translation"/>
<xs:enumeration value="description"/>
<xs:enumeration value="punct"/>
</xs:restriction>
</xs:simpleType>
<xs:simpleType name="itemTypes">
<xs:union memberTypes="knownltemTypes xs:string"/>
</xs:simpleType>
<xs:simpleType name="knownObjectTypes">
<xs:restriction base="xs:string">
<xs:enumeration value="NotebookRecord"/>
<xs:enumeration value="RoledParticipants"/>
</xs:restriction>
</xs:simpleType>
<xs:simpleType name="objectTypes">
<xs:union memberTypes="knownObjectTypes xs:string"/>
</xs:simpleType>
<xs:simpleType name="morphTypes">
<xs:restriction base="xs:string">
<xs:enumeration value="particle"/>
<xs:enumeration value="infix"/>
<xs:enumeration value="prefix"/>
<xs:enumeration value="simulfix"/>
<xs:enumeration value="suffix"/>
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<xs:enumeration value="suprafix"/>
<xs:enumeration value="circumfix"/>
<xs:enumeration value="clitic"/>
<xs:enumeration value="enclitic"/>
<xs:enumeration value="proclitic"/>
<xs:enumeration value="bound root"/>
<xs:enumeration value="root"/>
<xs:enumeration value="bound stem"/>
<xs:enumeration value="stem"/>
<xs:enumeration value="infixing interfix"/>
<xs:enumeration value="prefixing interfix"/>
<xs:enumeration value="suffixing interfix"/>
<xs:enumeration value="phrase"/>

<xs:enumeration value="discontiguous phrase"/>

</xs:restriction>

</xs:simpleType>

<xs:simpleType name="scrSectionTypes">

<xs:restriction base="xs:string">
<xs:enumeration value="title"/>
<xs:enumeration value="heading"/>
<xs:enumeration value="verseText"/>

</xs:restriction>

</xs:simpleType>

<xs:simpleType name="analysisStatusTypes">

<xs:restriction base="xs:string">
<xs:enumeration value="humanApproved"/>
<xs:enumeration value="guess"/>

<xs:enumeration value="guessByHumanApproved"/>
<xs:enumeration value="guessByStatisticalAnalysis"/>

</xs:restriction>
</xs:simpleType>
</xs:schema>
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